Introduction to MyInfoVault
A web based data repository and academic advancement & review program

Crystal Tobias
MIV Analyst, Academic Affairs
 cytobias@ucdavis.edu
530-752-8932
MIV – what you need to know

- MyInfoVault (MIV) is the official academic personnel system of UC Davis and the UC Davis Health System
- MIV is a robust data repository in which data is entered once and used for multiple outputs, including:
  - Creating, routing, reviewing, and archiving academic personnel actions
  - Creating and editing curriculum vitae and biographical sketches
  - MIV has a Decision Support feature that allows the campus to search the data in the standard MIV categories
    - Data uploads or entered in textboxes will not be searchable with Decision Support
    - Data in custom headers will be searchable but will show up in the search as the original header item (i.e., if a book chapter is listed in the journal category, it will count as a journal article even if the header was changed to “publications.”)
MIV – what you need to know

• Roles in MIV
  • Applicants: for new appointments only – cannot add or enter data themselves
  • Candidate: can enter and format data on their own behalf, route their dossier to the department, sign their disclosure certificate, review other dossiers assigned to them, and create their CV and bio sketch; can review dossiers in their own archive
    • All academic users are candidates; chairs, deans, and the Vice Provost have special designations that are assigned at the level above them
  • Department helper: can enter and format data, create and send a dossier on behalf of a candidate (as their proxy)
  • Department admin: can enter and format data, design, annotate and create dossiers, CVs and bio sketches on behalf of the candidate (as their proxy); can manage open actions by uploading PDFs, opening review periods, assigning reviewers, sending disclosures for signature, and routing dossiers forward and back; can add new users, edit existing user accounts and activate/deactivate user accounts in their unit; can review archived dossiers for faculty in their unit; create/Manage review groups; and can use Open Action reports to manage their workload
MIV – what you need to know

• School/College Admin: Can manage open actions for faculty at the S/C level, upload documents, open review periods, assign reviewers, route dossiers, act as a department admin for their units, and review the archive for candidates in their unit; can add, edit, activate and deactivate users in their unit; can hold and release the action for dean’s recommendation/approval; create/manage review groups; manage redelegated appeals; send dossiers to Ready for Post Audit Review; and can use Open Action reports to manage their workload

• Senate Admin: Can manage open actions at their level (Senate, Federation, and appeals), upload documents, and route the dossier forward and back; create/manage review groups; and can use Open Action reports to manage their workload

• MIV Admin: Can proxy all MIV users and act on their behalf, enter/format data, manage open actions and route dossiers at all levels; add, edit, activate and deactivate all MIV users; hold and release dossiers to the Vice Provost; create/manage review groups; cancel abandoned dossiers at the candidate’s level; send dossiers to post-audit/appeal and to the archive; and can use Open Action reports to manage their workload. MIV Admins also act as the “help” desk for MIV users.
MIV – what you need to know

• HELP! Now what do I do???
  • You can and should arrange for training.
    • Campus – Crystal Tobias (752-8932, cytobias@ucdavis.edu)
    • School of Medicine – Nichol Runner (916-734-4607, nichol.runner@ucdmc.ucdavis.edu)
  • Use the “How Do I Get Started” link on your MIV main page
  • Use the “Training & Resources” link on the Academic Affairs Tools > MyInfoVault page
Accessing MIV

- Request an account from your department admin
- The MIV user must be listed in the on-line campus directory
- Log in at: http://myinfovault.ucdavis.edu/
- Use your campus login ID and Kerberos passphrase which is vetted through the campus Central Authentication System (CAS)
Department Admin Main Page

Manage open actions and view snapshots of open actions here

Where you’ll find various MIV reports

This is where you proxy a candidate

Manage open actions and view snapshots of open actions here
Manage users here

Add a New User requires the user to have a valid UCD e-mail address in the campus on-line directory

Edit a user’s account is where you add joint appointments (faculty) or cluster assignments (staff)

Deactivate/Reactivate a user is where you remove access to your unit (which you should do when someone leaves your unit)

Manage Groups is where you create your review and voting groups (see handout at http://academicaffairs.ucdavis.edu/tools/miv-information/training-resources.html)

View archived dossiers here
Entering data on behalf of a candidate

• You must “select a user’s account” (proxy a candidate) to enter data for that person, which will give you the standard “search” box.

• You may search by candidate’s first or last name, first letter of last name, by department (or cluster), or by school/college.

Select a User’s Account: Search
Candidate’s Main Page
(department admin view as the candidate’s proxy)

Enter data here

Create, view and forward dossier here

Sign disclosure certificate here

Department admin

Name of proxied candidate

Enter Data ▼ My Dossier ▼ CV & Biosketches ▼ Actions ▼ Reports ▼ Preferences ▼

Learn how to enter data, create and design your dossier, and send your dossier to your department: How do I get started?

My Dossier
Create My Dossier
View My Dossier
Send Dossier To My Dept.

CV & Biosketches
Manage My Curriculum Vitae (CV)
Manage My NIH Biosketch

Completed Actions
View Dossier Archive

Reports
View MIV Users
View MIV Deans
View MIV Department Chairs
View MIV Open Actions
Candidate’s Main Page
(department admin view as the candidate’s proxy)

Create CV and bio sketch documents here

CV & Biosketches
Manage My Curriculum Vitae (CV)
Manage My NIH Biosketch

Completed Actions
View Dossier Archive

Reports
View MIV Users
View MIV Deans
View MIV Department Chairs
View MIV Open Actions

Name of proxied candidate
Department admin

(Bella Merlin) Return to My Account

Learn how to enter data, create and design your dossier, and send your dossier to your department: How do I get started?
Entering data on behalf of a candidate

- Data can be entered by the candidate*, or by a department helper, department admin, school/college admin or MIV admin as a proxy for that candidate
- Personal, education and employment data are for the curriculum vitae
- All other data categories are for various academic personnel actions for every academic series represented on the UC Davis campus
- Your dean’s office may have specific data entry requirements

*Exception – new appointees cannot enter their own data
Entering data on behalf of a candidate

• Required data fields are annotated with a *
• Every time data is added or edited, click the “save” button at the bottom of the page – **VERY IMPORTANT STEP!!**
• The saved data will briefly be highlighted in light green for ease of review
• Data must be added in the appropriate user account and category as it cannot be moved except by deleting and re-entering the data into the correct account/category
  • The exception to this is that you can move Publications data from one category to another using the drop-down menu in the data entry form
• You will get a pink screen/red warning if you try to enter data in an admin account
• Several data categories may be uploaded as PDFs:
  • Ag Experiment Station, Candidate Statement, Extending Knowledge, Position Description and DESII reports
• If you have questions about the proper location of data entry, contact your Dean’s Office
Agricultural Experiment Station Reports

- You may upload a PDF or enter information in the text boxes below (don’t forget to SAVE your work!)
- You can deselect obsolete AES reports in the Design My Dossier phase and leave them in MIV to reference for future career reviews

**Edit “Agricultural Experiment Station”**

This record was last edited 12-30-2013, 03:22 PM.

* = Required Field

**Michael Turelli**

Upload a PDF or enter data in the fields below.

* Date(s): 2014

* Project Title: Drosophile Melanogaster or Genetic Masterpiece?

Investigator Names: Turelli, Michael and Ian Boussy

Report number: CA-D*-EVE-4245-J

[Save] [Cancel]
Agricultural Experiment Station Reports

- To upload a PDF from your main toolbar, click Enter Data > Ag. Experiment Station > Add a New Record
- Enter the appropriate year, browse your computer files and choose the appropriate report
- You may create an optional custom name (i.e., AES Report #1 – Promotion 2014)
- Click “Upload PDF File”

Add "Agricultural Experiment Station" PDF Upload

*= Required Field

Michael Turelli

Year: 2014

* Upload PDF File:

[Browse] PDF AG EXPERIMENT STATION.pdf

Create an optional custom name for this file (default will be "Agricultural Experiment Station" if no custom name is entered):

[CA-D*-EVE-4245-J]

[Upload PDF File] [Cancel]
Candidate’s Statements

• Candidate Statement
  • Can be entered as text or uploaded as a PDF (the latter is the preferred method)
  • Should be no more than 5 pages long
  • Can be maintained in MIV and “turned off” when next dossier is created
  • When a career review is completed, all former Candidate Statements can be used to prepare an overall (career) Statement

• Candidate Diversity Statement
  • Entered as text, not as a PDF upload
  • Allows a candidate to highlight their diversity activities
  • Three categories
    • Teaching
    • University and Public Service
    • Scholarly and Creative Activities
Candidate’s Statements
Candidate’s Statements

• To upload a regular candidate’s statement from your main toolbar, click Enter Data > Candidate’s Statement > Candidate’s Statement > Add a New Record
• The preferred method of including the Candidate’s Statement is as a PDF upload (rather than as entry in the text box)
• Click on “Upload a PDF”

The candidate statement can also be entered as text, formatted and saved here using the WYSIWYG (what you see is what you get) toolbar – but that is NOT the preferred method of entering this data
Candidate’s Statements

• Enter the appropriate year
• Browse your computer files for the saved PDF document
• Click on the appropriate Candidate’s Statement
• You may create an optional custom name (i.e., Candidate’s Statement – Promotion 2014)
• Click “Upload PDF File”
• You do not need to delete obsolete Candidate’s Statements; you can deselect them in the Design My Dossier phase and leave them in MIV to reference for future career reviews
Candidate’s Diversity Statement

• The University of California is committed to excellence and equity in every facet of its mission
• Teaching, research, professional and public service contributions that promote diversity and equal opportunity are to be encouraged and given recognition in the evaluation of the candidate’s qualifications
• These contributions to diversity and equal opportunity can take a variety of forms including efforts to advance equitable access to education, public service that addresses the needs of California’s diverse population, or research in a scholar’s area of expertise that highlights inequalities
• Diversity statements are entered as text, not PDF uploads
Creative Activities Data Entry

• This category was designed for faculty in the arts or other areas of creativity (although they can be used by any MIV candidate if appropriate):
  • Music
  • Art Studio
  • Theatre and Dance
  • Design
  • Lighting
  • Poetry
Creative Activities Data Entry

• There are four categories of data entry under Creative Activities
  • Works
  • Events
  • Publication Events
  • Reviews by Others

• Works MUST associated with an Event or a Publication Event to show up in the dossier

• Events and Publication Events will show up in the dossier even if they are not associated with a Work because they can stand alone as creative activity
Creative Activities Data Entry

• A work is the initial creative work completed by the faculty member, and can include (but is not limited to) such items as:
  • Art (Drawing, Painting, Photography, Sculpture)
  • Design (Fashion, Lighting, Textiles)
  • Music (Composition, Performance)
  • Other (Playwriting, Directing, Poetry, etc.)

• All required data entry fields are marked with a *

• If your candidate’s work type is not listed, you may click on the link “Help! My work type is not listed” and you will be able to send an e-mail to the miv-help desk to request the addition of the work type to the drop-down menu

• Your request will be reviewed by the IET development team with input from the HArCS Dean’s Office
There are 34 types of works currently available.

For a work to show up in the dossier, it must be associated with an event or a publication event, which is done here.
Creative Activities Data Entry

• To associate a work with an event or publication event, the event or publication event must be previously entered before the association can be made
• The year of the work MUST occur on or before the date of the event or publication event
• A work may be associated with more than one event
• Multiple works may be associated with one event
• Always remember to save your work!
Creative Activities Data Entry

Events/publication events can also be entered from this screen.

<table>
<thead>
<tr>
<th>Available Events</th>
<th>Selected Events</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a New Event</td>
<td></td>
</tr>
<tr>
<td>Add a New Publication Event</td>
<td></td>
</tr>
</tbody>
</table>

**Association Rule:** Year of a work must occur on or before the associated event.

- Put your cursor on the available event(s) to highlight the selected item(s).
- Click >> to move the available event to the selected event field, or << to move it back to the available event list.

**Actions:**
- Save
- Cancel
Creative Activities Data Entry

Add “Events”

- There are 23 types of events currently available
- Events will show up in the dossier without an association with a work but should still be associated with any related work(s)

[Image of data entry form with example data]
Creative Activities Data Entry

- An event is the opportunity to showcase a work. Events that would be associated with a painting might include (but not be limited to) the following: Catalog, Exhibition (group or solo), or private/public collection
- Multiple events may be associated with one work
- The work must be previously entered before the association can be made
- To associate an event with a work, edit the data entry page for the event, and click on “Associate Works with this Event” to open the fields to add the work
- The date of the event must be on or after the year of the associated work
Creative Activities Data Entry

- Events will show up in the dossier even if they are not associated with a work, but associations should be made if a candidate’s work was used in an event or a publication event.

The work also may be added directly from this screen.

Put your cursor on the available work(s) to highlight the selected item(s).

Click >> to move the available work to the selected work field, or << to move it back to the available work list.
Creative Activities Data Entry

Add “Publication Events”

Crystal Y Tobias

* Year: 2009
* Status: Published

* Title: Still Life with Pileated Woodpecker

Publication Name: Natural Skies

* Authors:
Barber, Crystal

Editors: Smith and Jones
Publisher: Environmental Press
Country: US: United States
State/Province: California
City: Folsom
Volume: 27
Issue: 27
Pages: 27
URL:

* Associate Works with this Event

Publication Events are handled the same way as regular events, except the author of the publication event may be someone other than the candidate; in that case, the publication event will need to be associated with a work credited to the candidate.

**Example:** Someone other than the candidate publishes a book and uses the candidate’s art or photography in the book.
Creative Activities Data Entry

Print and media reviews are reviews authored by others regarding a work or an event by the candidate. The candidate’s work or event must be associated with the print or media review. Data in one category (i.e., print review) must be saved before doing data entry in the other category (i.e., media review).
Extending Knowledge Data Entry

- This category is used primarily by Specialists in Cooperative Extension.
- It is designed to show the candidate’s “extension” of their knowledge to the State of California based on UC’s land grant institution status.
- There are two named categories:
  - Broadcast, print or electronic media.
  - Workshops, Conferences, Presentations and Short Courses.
- There is an “Other” category for other items.
- You may also upload this list as a PDF in the same fashion as the Candidate’s Statement.
Extending Knowledge Presentations vs. Publications Presentations

**Data Entry**

- **Extending Knowledge > Presentations**
  - This category was originally designed for Specialists in Cooperative Extension
  - They “extend” their knowledge to the lay public of the State of California
  - Part of UC’s Land Grant institutional mission

- **Publications > Presentations**
  - This category is for presentations that are designed for and presented to the scientific, scholarly or creative arts community in the candidate’s area of expertise
Grants and Contracts

Three types of grants and "other" category

Five status options. "Active" and "Completed" status require a start date to be entered

Seven possible roles for a candidate
Patents and Disclosures

• Patents and Disclosures can be found under Enter Data > Publications > Patents

• If your Patent Jurisdiction is not listed in the drop-down menu, you may contact miv-help@ucdavis.edu and request that it be added

• Contributions to Jointly Authored Patents and Disclosures can be found at the bottom of the data entry page, and show up on the Contributions to Jointly Authored Publications PDF

• Click on ▶ to expand sections for data entry
Patents and Disclosures

Two patent status options

Crystal Y Tobias

Type: Patent

Disclosure

Patent
Status: Filed

Select whether this is a pending patent application or a granted patent.

* Title:

* Inventors:

Jurisdiction: United States (USPTO)
Help! My Jurisdiction is not listed

* Application number:
* Application date:

Patent number:
Patent date:

URL:

Contributions, etc.

Save Cancel

Crystal Y Tobias

Type: Patent

Disclosure

Title:

Inventors:

Disclosure number: Disclosure date:

Contributions, etc.

Save Cancel
Honors and Awards

- Very straightforward data entry required
- It is helpful to indicate if the award is local, statewide, national or international

Enter a brief description of the award.
List of Evaluations

- Unit 18 Initial Continuing Appointments require complete sets of all evaluations be included for the review period.
- All other advancement actions require two complete sets and summaries of the rest.

Enter Quarter and Year in a consistent manner, i.e., Fall 2013, SP 2014.

Indicate whether Summary or Complete here.

MIV calculates rate of response if Total Enrollment and Total Responses boxes are filled out.

URL for programs with an on-line teaching evaluation program.
Position Description

- Position Descriptions (PD) are for Academic Federation series
- The Federation Central Review Committees require the candidate and their supervisor both sign the PD
- The signed PD must be uploaded as a PDF
- More than one PD may be entered for each dossier depending on the candidate’s grant funding/position duties over the course of the review period
- PDs may be retained in MIV, and deselected when they are no longer valid
- PDs are uploaded by browsing, selecting and uploading the PDF in the same fashion as the candidate’s statement
Publication Data Entry

- There are 11 publication data entry categories (not including “Additional Information”)
- Data may be manually entered
- Data may be downloaded from PubMed (for any research having to do with human or animal health sciences) – see link on Publications > Journals page:
  
  Download Journal entries from the MEDLINE database through the PubMed Download utility.

- Data may also be imported from EndNote by following the instructions at:
  https://myinfovault.ucdavis.edu/miv/help/ontime_data_imports.html

- Always remember to save your data entry
Publication Data Entry

• Tips for using PubMed Download feature
  • Check how MIV pre-populates the name when using this feature
  • If the name is not the same as what the candidate uses on their publications, enter the correct name
  • If the name is common and you get many results, entering the candidate’s middle initial may help narrow the results
  • You can also use the custom search feature, and search by a smaller (maybe two year) period; that will make it easier for you to identify your candidate’s articles
  • Check the items to import into the candidate’s account
  • Remember to save your work after checking items to be imported
Publication Data Entry

• Publications can be entered as submitted, in press or published

• Publication status changes will allow publications to migrate from submitted, to in-press, to published without having to do new data entry
  • Update publication information if it changes along the way

• Contributions to Jointly Authored Works are entered at the bottom of the publication data entry page and show up on their own list

• Special Character Palette for symbols, Greek alphabet and super- and subscript items
Publication Data Entry

Status can be updated from submitted to in-press to published

Data can be moved from one publication category to another simply by using this drop-down menu

These three categories are used only for items related to books and will not show up in the other publication data entry categories

If the URL takes you directly to the article you do not need to submit a hard copy with the dossier

Contributions and significance show up on their own list in the PDFs
List of Service

Administrative Assignments are for assignments on or related to the Davis Campus or Health System.

Crystal Y Tobias

Administrative Assignments are things such as Department Chair, Division Chief, Medical/Clinical Service Director, Graduate Group Director, etc.

- Administrative Title & Institution: 
- Start Year:  
- End Year:  
- Percent Effort:  %

[Save] [Cancel]
List of Service

Be consistent within date category on how dates are entered, i.e., 2011-2012 or 2011-12

Committee Service can be provided to Department/Section, School/College, Campus, Systemwide, Other University and Other Non-University

Committee role is Chair, Member, ex officio, etc.
Teaching

When data is entered in Teaching categories, the PDF output is the Teaching, Advising and Curricular Development form (an Academic Senate form).

If you upload the DESII report, you do not need to enter Contact Hours or Courses.

DESII reports should be uploaded as portrait rather than landscape.

Trainees can be undergrads, grad students, or postdoctoral fellows.

Professional schools may upload their teaching reports in lieu of the DESII.
Special Data Entry Character Palette

Special Character Palette is available on all data entry and text box locations.

Put your curser where you want the new character and click on the character in the palette.

Highlight items to super- or sub-script and click on the item in the palette.
Additional Information Categories

- There are four “Additional Information” categories (text boxes rather than data entry) that are available for use in dossiers:
  - Creative Activities
  - Publications
  - Service
  - Teaching
- These categories may be used if the candidate’s data does not fit neatly into standard categories
- These categories are not searchable by Decision Support
- You will need to create a header for each category of additional information
Fine Tuning the Dossier

• Once entered and saved, you are able to format and annotate the candidate’s data
• You must be in the candidate’s account to use these features
  • Lines denoting the review period can be added to
    • Creative Activities
    • Extending Knowledge
    • List of Evaluations
    • Publications
    • Service
• Annotations can be added to:
  • Creative Activities
  • Publications
Drawing Lines & Adding Labels

• Lines are drawn to denote the review period ("below the line")
• To draw lines and add labels to the Publication List, select My Dossier > Dossier Design > Manage (appropriate category) Annotations
• Click "Edit" on the item above or below where you want your line
• Choose “Label Above” or “Label Below”
• Choose “Left Justify” or “Right Justify”
• Enter your Label, i.e. “Merit to Professor Step II effective July 1, 2010”
• Always remember to “Save” your work
• Items reviewed previously should be above the line
Drawing Lines & Adding Labels

Line labels are entered here
Drawing Lines & Adding Labels

- Your line will appear on the Journals list and in the PDF once the dossier has been created.
- To remove the line, click “Edit” and simply delete the label text from the data entry box, then click “Save”.

**Journals**

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>2011</strong> Tobias, C. and C. Watts. How to Teach MIV at Davis. 27(27): 27-72.</td>
<td></td>
</tr>
</tbody>
</table>

*Merit to Professor Step II effective 7/1/10*
Drawing Lines & Adding Labels

- This is how lines will appear once the dossier has been created

<table>
<thead>
<tr>
<th>Journals</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Merit to Professor Step II effective 7/1/10</strong></td>
</tr>
</tbody>
</table>
Annotations & Footnotes

• Annotations and Footnotes are to designate specific details about the item to which they are attached
• You may annotate and footnote Publication and Creative Activities Lists
• Go to My Dossier > Dossier Design > Manage (appropriate category) Annotations (for both annotations and footnotes)
• There are four standard annotations:
  • * = article is included in the review period, and is available to reviewers either on-line or in hard copy
  • x = most significant work (no more than 5 per review period)
  • + = major mentoring role
  • @ = refereed
Annotations & Footnotes

• Footnotes are used to bring an issue to the attention of the review committee and are indicated with a “#”

• Two common uses of the footnote feature are to identify an article that may have been omitted from an earlier review, or if the article falls below the line due to the publication date, but was considered in an earlier review as an “in press” item

• If a publication list has been significantly renumbered due to separation of articles into distinct categories, footnoting the articles in the review period to indicate renumbering would be appropriate
Annotations & Footnotes

Annotations are entered here. More than one annotation may be added to each publication.

Footnotes are entered here. Only one footnote can be added to each publication.
Annotations & Footnotes

• Once you save your annotation or footnote entry and create your dossier, the annotation/footnote symbols will show up next to the related publication, and the annotation key and your footnote will be at the bottom of that list in the PDF.

Merit to Professor Step II effective 7/1/10


Promotion to Professor A/S 7/1/12

6. 2012 Tobias and Jones. This is a test -- 10/9/12. Test journal, 27(27): 27.


Footnotes:
#4. This article was omitted from earlier review and should be considered in the current review (2013-14).

Notations:
* = Publication included in the packet.
 x = Most significant works.
Preferences

- Preferences are ways of highlighting the data so that it stands out (by bolding, underlining or italicizing)
- Preferences may be applied to Creative Activities, Extending Knowledge, and Publications
- From your menu toolbar, choose Preferences > Manage Format Options > (appropriate category)
- The most common preferences are:
  - Bolding an author’s name (Tobias, C.Y.)
  - Underlining a scientific term (Drosophila melanogaster or D. melanogaster, aka the common fruit fly!)
Preferences

You may choose to format an entire field here

You may choose to format specific names or terms here. They must be entered every way that they appear in the data entry fields, including spaces and punctuation

Click here to add a new pattern

<table>
<thead>
<tr>
<th>Data Category: Field Name</th>
<th>Pattern</th>
<th>Format Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publications: Authors</td>
<td>C. Y. Tobias</td>
<td>B I U</td>
</tr>
<tr>
<td>Publications: Authors</td>
<td>C.Y. Tobias</td>
<td>B I U</td>
</tr>
<tr>
<td>Publications: Authors</td>
<td>Tobias, C.Y.</td>
<td>B I U</td>
</tr>
<tr>
<td>Publications: Title</td>
<td>D. melanogaster</td>
<td>B I U</td>
</tr>
<tr>
<td>Publications: Title</td>
<td>Drosophila melanogas</td>
<td>B I U</td>
</tr>
</tbody>
</table>
### Preferences

All publication titles are now underlined.

<table>
<thead>
<tr>
<th>Journals</th>
</tr>
</thead>
</table>

**Merit to Professor Step II effective 7/1/10**


**Promotion to Professor A/S 7/1/12**

6. 2012 Tobias and Jones. This is a test -- 10/9/12. Test journal, 27(27): 27. |


**Footnotes:**

#4. This article was omitted from earlier review and should be considered in the current review (2013-14).

**Notations:**

* = Publication included in the packet.

x = Most significant works.

The author’s name is now bolded based on each pattern that was entered on the Preferences screen.
Designing the Dossier

• Once all of the data is entered appropriately, lines have been drawn and any formatting preferences applied, the next step is to design the dossier.

• The candidate or their proxy (usually the department admin) must do this step in the candidate’s account by choosing My Dossier > Dossier Design > Design My Dossier.

• This is when the candidate determines what information is to be included in the current dossier.

• Items to be included in the dossier must have a “√” in the box next to the item.

• If you create the dossier and the item does not show up in the PDF, it either has not been checked in the Design My Dossier step, or it is a Work not associate with an Event.
Designing the Dossier

- From your main menu bar, select My Dossier > Dossier Design > Design my Dossier
Designing the Dossier

- Expand each category by clicking on the + sign.
- Item to be included must be checked.
- You may “clear all” or “clear section” to remove all checkmarks, or “check all” or “check section” to add checkmarks to all items.

The candidate and/or their proxy should review every section of the dossier to determine which items should be listed in the current dossier.
Designing the Dossier

All publications should be checked for an advancement. Contributions should only be checked for items in the review period. Section headers must also be checked to show up in the dossier. Even though it does not show on this page, don’t forget to SAVE YOUR WORK.
Creating the Dossier

• You can create the dossier from the candidate’s main toolbar

• You can also create the dossier from the candidate’s main MIV page

Learn how to enter data, create and design your dossier, and send your dossier to your department: [How do I get started?](#)
Creating the Dossier

• The dossier must be created in the candidate’s account before sending it to the department in order to capture all of the data items that have been selected in the “Design My Dossier” location
• The dossier must be recreated each time additional data is added or edited in the candidate’s account, if that data is to be included in the dossier
• You can create the dossier as many times as you want in order to review the dossier in the final format
• The dossier will not be finalized until it is sent to the department
• The data in the dossier can still be edited if the dossier is returned to the candidate’s level
Sending Dossier to the Department

- The dossier can be sent to the department from the candidate’s main toolbar
- The dossier can also be sent to the department from the candidate’s main MIV page

Learn how to enter data, create and design your dossier, and send your dossier to your department: [How do I get started?](#)

- My Dossier
  - Create My Dossier
  - View My Dossier
  - Send Dossier To My Dept.
Sending Dossier to the Department

• The candidate or their proxy selects the action type and effective year

Send Dossier To My Dept.

Candidate: Crystal Y Tobias
View My Dossier as One PDF File (Last created: 09/18/13, 4:51 PM)

Please review your dossier via the link above for completeness. If your dossier is missing data that you have added since its last created date, create your dossier again to include the new data. Be sure that the dossier does not contain recently added data that should not be included in this review. For example, if the dossier was returned to the candidate for updates and then recreated, all recently added data would appear in this dossier. Uncheck the print options in the design my dossier page for the data you do not want to appear in this dossier.

When you send your dossier to your department it will be transferred to a secured location, and will no longer be available for changes.

Action Type: Merit ▼ Effective Date: July 1, 2014 ▼ Send Dossier To My Department ▼ Cancel

If you have problems creating or viewing your dossier, please contact the MIV Project Team at miv-help@ucdavis.edu.
Sending Dossier to the Department

• There are now 20 action types from which to choose using the drop-down menu (this does not include new appointments for appointees not yet affiliated with UC Davis)

Send Dossier To My Dept.

Candidate: Crystal Y Tobias
View My Dossier as One PDF File (Last created: 09/18/13, 4:51 PM)

Please review your dossier via the link above for completeness. If your dossier is missing data that you have added since its last created date, create your dossier again to include the new data. Be sure that the dossier does not contain recently added data that should not be included in this review. For example, if the dossier was returned to the candidate for updates and then recreated, all recently added data would appear in this dossier. Uncheck the print options in the design my dossier page for the data you do not want to appear in this dossier.

When you send your dossier to your department it will be transferred to a secured location, and will no longer be available for changes.

Action Type: Merit  ▼ Effective Date: July 1, 2014  Send Dossier To My Department  Cancel

If you have problems creating or viewing your dossier, please contact the MIV Project Team at miv-help@ucdavis.edu.
Sending Dossier to the Department

- Dossier Options include:
  - Endowed Chair, Professorship and Specialist in CE Appointment
  - Initial Continuing Appointment – Unit 18 NSF
  - Appointment via change in Department
  - Appointment via change in Title
  - Appraisal (without merit at this time)
  - 1st Year, 2nd Year, 3rd Year and 4th Year Deferral
  - Emeritus Status
  - Five Year Review
  - Five Year Review – Department Chair Review
  - Merit – required to be processed in MIV unless an exception is granted
  - Promotion – required to be processed in MIV unless an exception is granted
  - Reappointment
  - Endowed Chair, Professorship and Specialist in CE Reappointment
Sending Dossier to the Department

- After you send the dossier to the department, you will get a confirming message that tells you the name of the candidate, the school, the department, the action, and the date and time submitted:

```
Send Dossier To My Dept.: Confirmation

The following dossier has been sent to:
- School of Medicine - Psychiatry and Behavioral Sciences

Candidate: Thomas F Anders
Dossier: Promotion 2014 (Submitted 09/25/13, 11:36 AM)
```
Managing the Open Action

• Once the dossier is sent to the department, it becomes an open action to be managed from the department admin’s account

• As the department admin, you can manage open actions in two ways:
  • From your main toolbar by choosing Actions > Open Actions > Manage Open Actions
  • From your MIV main page by selecting Open Actions > Manage Open Actions
Managing the Open Action

Manage open actions from either of these locations (may be done by department admin, or school/college or MIV admin)
Managing the Open Action

- You will receive the standard “search” box to search for an open action.
- You can search by the candidate’s first or last name.
- You can also search by first letter of last name.
- You are able to search by department or cluster.
- You are also able to search by school/college (for S/C or MIV admins).
Managing the Open Action

- Upon opening the action, you will get a standard menu of items that encompasses some appointment* and all advancement actions for all series on the Davis campus
  * The exception is new appointments, which have their own menu
- There are thirteen optional (green) items
- There are three required (red) items that need to be completed before the action can be forwarded to the next level:
  - The Recommended Action Form
    - Should be the first thing done when the dossier arrives at the department location
  - The Department/Division Letter
  - The Candidate’s Disclosure Certificate
    - Should be the very last thing completed before sending the dossier to the school/college location because, by signing the CDC, the candidate is approving the final, completed dossier
    - If changes are made to the dossier, a new disclosure is required
Managing the Open Action

Any red items will not allow the dossier to be forwarded to the Dean’s Office.

<table>
<thead>
<tr>
<th>Recommended Action Form</th>
<th>Add/Edit</th>
<th>Required - Not Added</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department Letter/Division Chief Letter</td>
<td>Add/Delete</td>
<td>Required - Not Added</td>
</tr>
<tr>
<td>Department Letter Federation Vote</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Department Peer Group Letter for Federation</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Candidate’s Disclosure Certificate</td>
<td>Add/Delete</td>
<td>Required - Not Added</td>
</tr>
<tr>
<td>Rebuttal Letter</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Rejoinder Letter</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Peer Evaluation of Teaching Performance</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Evaluation Letter of Graduate Group Chair Service</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>OVCR Evaluation Letter for Research Unit Director</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Director Evaluation Letter of Clinical Activities</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Evaluation Letter of Academic Senate Committee Service</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Extramural Letter(s)</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Org Chart</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
</tbody>
</table>

Return This Dossier to the Candidate (No documents/letters will be visible to the Candidate, nor will they be deleted from the dossier)
Managing the Open Action

• From the open action page, you can:
  • Add or edit the Recommended Action Form
  • Upload documents required for that action (see appropriate checklist at https://academicaffairs.ucdavis.edu/resources/forms_checklists/index.html)
  • Upload extramural letters as redacted and non-redacted
  • Open the review period and assign reviewers
  • Edit and send the Candidate’s Disclosure Statement
  • Route the open action forward to the dean’s office or back to the candidate for further work on the data
  • View the dossier as one PDF
  • View the signature log (new feature as of 9/24/13)
Managing the Open Action

<table>
<thead>
<tr>
<th>Open Action</th>
<th>Required - Not Added</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Kelly Anders</strong></td>
<td>Offices of the Chancellor and Provost</td>
</tr>
<tr>
<td><strong>Non-Redelegated Merit 2014</strong></td>
<td>Submitted on 09/25/2013, 11:48 AM</td>
</tr>
<tr>
<td>Department Location</td>
<td>Last Routed on 09/25/2013, 11:48 AM</td>
</tr>
<tr>
<td><strong>Primary Appointment:</strong></td>
<td>Offices of the Chancellor and Provost</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Recommended Action Form</th>
<th>Add/Edit</th>
<th>Required - Not Added</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department Letter/Division Chief Letter</td>
<td>Add</td>
<td>Required - Not Added</td>
</tr>
<tr>
<td>Department Letter Federation Vote</td>
<td>Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Department Peer Group Letter for Federation</td>
<td>Add</td>
<td>Required - Not Added</td>
</tr>
<tr>
<td>Candidate's Disclosure Certificate</td>
<td>Add/Edit</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Rebuttal Letter</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Rejoinder Letter</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Peer Evaluation of Teaching Performance</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Evaluation Letter of Graduate Group Chair Service</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>OVCR Evaluation Letter for Research Unit Director</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Director Evaluation Letter of Clinical Activities</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Evaluation Letter of Academic Senate Committee Service</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Extramural Letter(s)</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Org Chart</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Reviewing (Assign Reviewers)</td>
<td>Open/Closed</td>
<td>Optional - Not Open</td>
</tr>
<tr>
<td>Voting Period</td>
<td>Open/Closed</td>
<td>Optional - Not Open</td>
</tr>
</tbody>
</table>

**New feature**

**Optional items for upload based on APM UCD 220 checklists for appropriate action and series**

**3 required (red) items**

Return This Dossier to the Candidate (No documents/letters will be visible to the Candidate, nor will they be deleted from the dossier)
Recommended Action Form

- Click Add/Edit to enter data in the Recommended Action Form (RAF)
- This allows you to select the action type and the delegation of authority for the action submitted on behalf of the candidate
- The RAF should be the first thing completed at the department level
- Information on the RAF completes the candidate’s disclosure certificate
Recommended Action Form

- Select the Action Type, Delegation of Authority, and Option (if the latter category is presented to you, as it would be in the Deferral selection)
- Click “Select Action”
Recommended Action Form

• The RAF is now created in two steps
  • Step 1 includes the ability to change the delegation of authority and the effective date from the initial submission, enter the end date (for certain academic titles) and years accelerated
  • Step 2 is the Appointment details
Recommended Action Form

Step 2 is when you enter the details of the present and proposed actions for the home and joint department(s). If the joint department(s) is missing, the dossier must be returned to the candidate’s level for the addition of the joint department(s).
Recommended Action Form

- As with other data fields in MIV, the RAF required fields are indicated with a (*).
- The home and joint appointments must add up to the total percentage of the appointment and each area on the RAF has two locations for percentage of time.
- If the action is WOS, check the Without Salary box.
- WOS appointments should be entered as 0% of time.
Recommended Action Form

- The Department field(s) on the RAF will pre-populate based on the candidate’s home (and joint) appointments listed in their MIV account.
- If all appointments are not listed, you must return the dossier to the candidate’s level, add the missing appointments, re-create the dossier and re-send it to the department.
- You will need to manually enter the following items:
  - Percent of time (in two locations on each RAF field) – all appointments must add up to the total percentage.
  - Title code, rank, title and step.
  - Basis/Paid over (three options in a drop-down menu).
  - Salary period (monthly or hourly).
  - Salary amount (based on salary period chosen).
  - Years at Rank and Step (only on present status side and NOT a field on new appointment RAF).
- Remember to **SAVE YOUR WORK** after all data is entered.
Uploading Dossier Documents

• The open action page allows you to upload the entire spectrum of documents that are required for all advancement actions and some appointment actions for all series, with one exception
• **Confidential Chair’s Letters** will need to be submitted in hard copy as these are documents that the candidate cannot see unless requested after the review is completed
• Uploads must first be saved as PDF documents
• Two department letters may be uploaded for each of the candidate’s appointment (home and joint)
• To upload a PDF, click “add” next to the item, browse your computer, create an optional custom name if desired, and click “Upload PDF File”
Uploading Dossier Documents

<table>
<thead>
<tr>
<th>Primary Appointment:</th>
<th>Offices of the Chancellor and Provost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Appointment processing:</td>
<td>In Progress</td>
</tr>
</tbody>
</table>

- **Recommended Action Form**: Add/Edit [View: Recommended Action Form]
- **Department Letter/Division Chief Letter**: Add, Delete (Required - Not Added)
- **Department Letter Federation Vote**: Add, Delete (Optional - Not Added)
- **Department Peer Group Letter for Federation**: Add, Delete (Optional - Not Added)

---

**Add "Department Letter/Division Chief Letter" PDF Upload**

Confidential Chair’s letters should not be uploaded in MIV. Please submit Confidential Chair’s letters via hardcopy outside of MIV.

* = Required Field

---

**Crystal Y Tobias**

- **Upload PDF File**: Browse...
- **Create an optional custom name for this file** (default will be "Department Letter/Division Chief Letter" if no custom name is entered):
  
  - Enter custom name
  - **Upload PDF File**
  - **Cancel**
Uploading Extramural Letters

• This is a critical step, and the integrity of the dossier is at stake if an error is made.
• There is no default choice for uploading extramural letters, which are uploaded as PDF documents.
• It is the department admin’s responsibility to ensure that the extramural letters are uploaded correctly.
• If a non-redacted letter is uploaded as redacted, the candidate would see who wrote that letter and confidentiality would be breached.
• If confidentiality is breached, the campus can never use that extramural reviewer for any other campus review.
Uploading Extramural Letters

- Extramural letters must be uploaded as PDFs both as redacted (for the candidate’s view and archive of the dossier) and non-redacted (for all other purposes including the admin archive)

Select “Add” to upload Extramural letters
Uploading Extramural Letters

- Save extramural letters as PDFs, both as redacted and non-redacted
- Browse and find the desired PDF
- Create an optional custom name (required if uploaded as individual documents and resequenced)
- Choose redacted or non-redacted (very critical to select the correct option)
- Upload PDF file

Add "Extramural Letter" PDF Upload

* = Required Field

Crystal Y Tobias

Confidential Chair’s letters should not be uploaded in MIV. Please submit Confidential Chair’s letters via hardcopy outside of MIV.

* Upload PDF File:

Create an optional custom name for this file (default will be "Extramural Letter" if no custom name is entered):

Reviewer #11

* Letter Type:  
- Redacted
- Non-Redacted

Candidates view "Redacted" letters. Reviewers and Administrators view "Non-Redacted" letters.

Definition of "Redacted" and "Non-Redacted" documents
Uploading Extramural Letters

<table>
<thead>
<tr>
<th>Primary Appointment: Offices of the Chancellor and Provost</th>
</tr>
</thead>
</table>

**Primary Appointment processing:** In Progress

<table>
<thead>
<tr>
<th>Document Type</th>
<th>Add/Edit</th>
<th>View:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recommended Action Form</td>
<td>Add/Edit</td>
<td>View: Recommended Action Form</td>
</tr>
<tr>
<td>Department Letter/Division Chief Letter</td>
<td>Add/ Delete</td>
<td>View: Department Letter/Division Chief Letter</td>
</tr>
<tr>
<td>Department Letter Federation Vote</td>
<td>Add/ Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Department Peer Group Letter for Federation</td>
<td>Add/ Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Candidate's Disclosure Certificate</td>
<td>Add/Edit</td>
<td>View: Candidate's Disclosure Certificate</td>
</tr>
</tbody>
</table>

**Rebuttal Letter**
- Add/ Delete
- Optional - Not Added

**Rejoinder Letter**
- Add/ Delete
- Optional - Not Added

**Peer Evaluation of Teaching Performance**
- Add/ Delete
- Optional - Not Added

**Evaluation Letter of Graduate Group Chair Service**
- Add/ Delete
- Optional - Not Added

**OVCR Evaluation Letter for Research Unit Director**
- Add/ Delete
- Optional - Not Added

**Director Evaluation Letter of Clinical Activities**
- Add/ Delete
- Optional - Not Added

**Evaluation Letter of Academic Senate Committee Service**
- Add/ Delete
- Optional - Not Added

**Extramural Letter(s)**
- Add/ Delete
  - View: Reviewer #1 (Redacted)
  - View: Reviewer #1 (Non-Redacted)

Optional custom name for resequencing.

Redacted or Non-Redacted
Uploading Extramural Letters

- Once you have uploaded your extramural letters, return to your open action page.
- Click on each uploaded letter to ensure that they have been appropriately uploaded and labeled as either redacted or non-redacted.
- You may then resequence your letters to put them in the correct order.
- The resequence feature allows you to drag and drop the list of reviewers, the sample letter, the non-redacted and the redacted letters into the preferred order.
- Custom names (Reviewer #1, Reviewer A) are necessary for you to resequence the documents in MIV.
## Uploading Extramural Letters

<table>
<thead>
<tr>
<th>Location: Department</th>
<th>View The Dossier as One PDF File</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Primary Appointment</strong>: Information and Educational Technology - Application Development</td>
<td><strong>Primary Appointment processing</strong>: In Progress</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Recommended Action Form</th>
<th>Add/Edit</th>
<th>View Recommended Action Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department Letter/Division Chief Letter</td>
<td>Add/Edit</td>
<td>Required - Not Added</td>
</tr>
<tr>
<td>Department Letter Federation Vote</td>
<td>Add/Edit</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Department Peer Group Letter for Federation</td>
<td>Add/Edit</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Candidate’s Disclosure Certificate</td>
<td>Add/Edit</td>
<td>Required - Not Added</td>
</tr>
<tr>
<td>Rebuttal Letter</td>
<td>Add/Edit</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Rejoinder Letter</td>
<td>Add/Edit</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Peer Evaluation of Teaching Performance</td>
<td>Add/Edit</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Evaluation Letter of Graduate Group Chair Service</td>
<td>Add/Edit</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>OVCR Evaluation Letter for Research Unit Director</td>
<td>Add/Edit</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Director Evaluation Letter of Clinical Activities</td>
<td>Add/Edit</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Evaluation Letter of Academic Senate Committee Service</td>
<td>Add/Edit</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Extramural Letter(s)</td>
<td>Add/Edit</td>
<td></td>
</tr>
<tr>
<td>Add/Review</td>
<td>View List of Reviewers (Non-Redacted)</td>
<td></td>
</tr>
<tr>
<td>Add/View</td>
<td>View Sample solicitation letter (Non-Redacted)</td>
<td></td>
</tr>
<tr>
<td>Add/View</td>
<td>View Reviewer A (Non-Redacted)</td>
<td></td>
</tr>
<tr>
<td>Add/View</td>
<td>View Reviewer B (Non-Redacted)</td>
<td></td>
</tr>
<tr>
<td>Add/View</td>
<td>View Reviewer C (Non-Redacted)</td>
<td></td>
</tr>
<tr>
<td>Add/View</td>
<td>View Reviewer D (Non-Redacted)</td>
<td></td>
</tr>
<tr>
<td>Add/View</td>
<td>View Reviewer E (Non-Redacted)</td>
<td></td>
</tr>
<tr>
<td>Add/View</td>
<td>View Reviewer F (Non-Redacted)</td>
<td></td>
</tr>
<tr>
<td>Add/View</td>
<td>View Reviewer A (Redacted)</td>
<td></td>
</tr>
<tr>
<td>Add/View</td>
<td>View Reviewer B (Redacted)</td>
<td></td>
</tr>
<tr>
<td>Add/View</td>
<td>View Reviewer C (Redacted)</td>
<td></td>
</tr>
<tr>
<td>Add/View</td>
<td>View Reviewer D (Redacted)</td>
<td></td>
</tr>
<tr>
<td>Add/View</td>
<td>View Reviewer E (Redacted)</td>
<td></td>
</tr>
<tr>
<td>Add/View</td>
<td>View Reviewer F (Redacted)</td>
<td></td>
</tr>
</tbody>
</table>

Custom names are required to resequence.
Uploading Extramural Letters

• You may also upload letters as a single document by type if all letters have been received
• For Non-Redacted:
  • Upload this group first in the following order
    • List of extramural reviewers stamped “confidential” and numbered
    • Sample of solicitation letter with no reviewer names or addresses
    • Non-redacted letters stamped “confidential”, with a label indicating whether the letter is arm’s length or not, and if it was chosen by the candidate or the department chair, numbered to correspond with list
    • Letters should be in the order of the list of reviewers
• For Redacted:
  • Upload this group second
    • Redacted letters stamped “confidential” with no other identifiers except numbers to correspond with the list
    • No other documents uploaded in this group
    • Letters should be in the order of the list of reviewers
Redacted vs. Non-Redacted

**REDACTED**
- Must be marked “confidential”
- The candidate can only see the redacted version, both when signing the disclosure certificate and in the candidate’s archive
- All identifying information from the letter writer must be removed by the department admin except for information included in the body of the letter (headers, signature blocks & below are redacted)
- Do NOT label redacted letters with arm’s length or whether chosen by the candidate or chair
- Only identifier should be “Reviewer #1” or “Reviewer A” in upper right corner

**NON-REDACTED**
- Must be marked “confidential”
- All administrators and reviewers see this version, both during review of the dossier and in the admin and full archives
- Letter remains intact (no information is removed)
- Must be labeled as “arm’s length” or “not arm’s length” and whether chosen by the candidate or the department chair
- Must also be labeled as “Reviewer #1 or Reviewer A” in upper right corner
Opening Review Period

• To open the review period for a dossier, you must be in the candidate’s open action
• From your MIV main page, go to Open Actions > Manage Open Actions, and search for the dossier by candidate’s name, first letter of last name, or by department
• You may also go to your main toolbar and select Actions > Open Actions > Manage Open Actions and search as above
• Find “Reviewing (Assign Reviewers)” on the open action menu, and click “Open” to open the review period
• Clicking “Open” allows assigned reviewers to see the action
• If assigned reviewers cannot view the dossier, check to make sure the review period has been opened
• Only MIV candidates can be assigned as reviewers to a dossier
• See “Manage Groups” handout to establish standing review groups
Opening Review Period

To open the review period, click on “Open”

Clicking “Open” here opens the review period, which must be opened in order for assigned reviewers to view the dossier.
Assigning Reviewers

- Reviewers may be assigned from all campus MIV users, not just those from your unit

<table>
<thead>
<tr>
<th>Primary Appointment</th>
<th>Information and Educational Technology - Application Development</th>
</tr>
</thead>
</table>

| Primary Appointment processing | In Progress |

<table>
<thead>
<tr>
<th>Recommended Action Form</th>
<th>Add/Edit</th>
<th>View: Recommended Action Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department Letter/Division Chief Letter</td>
<td>Add/Delete</td>
<td>View: Department Letter/Division Chief Letter</td>
</tr>
<tr>
<td>Department Letter Federation Vote</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Department Peer Group Letter for Federation</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Candidate's Disclosure Certificate</td>
<td>Add/Edit</td>
<td>View: Candidate's Disclosure Certificate Required - Added but Not Emailed</td>
</tr>
<tr>
<td>Rebuttal Letter</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Rejoinder Letter</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Peer Evaluation of Teaching Performance</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Evaluation Letter of Graduate Group Chair Service</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>OYCR Evaluation Letter for Research Unit Director</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Director Evaluation Letter of Clinical Activities</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Evaluation Letter of Academic Senate Committee Service</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Extramural Letter(s)</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Org Chart</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Reviewing (Assign Reviewers)</td>
<td>Open/Closed</td>
<td>Open</td>
</tr>
<tr>
<td>Voting Period</td>
<td>Open/Closed</td>
<td>Optional - Not Open</td>
</tr>
</tbody>
</table>

Click here to Assign Reviewers – either individually or as part of an established review group
Assigning Reviewers

Assign Dossier Reviewers

Name: Peter Siegel  
Appointment: Information and Educational Technology  
Location: Department  
Review Period: Open

Select reviewers for this dossier from the available users and groups.

A Reviewing period must be “Open” in order for the assigned reviewers to be able to view dossiers.

Note: Reviewers do not have to be removed from the assigned reviewers list after the review period is complete. When a dossier is routed to the next location (e.g. from Department to School/College) reviewers at the previous location (Department) can no longer view the dossier. If a dossier is returned to a previous location for corrections, assigned reviewers remain assigned but cannot view the dossier until it is routed forward again.

You can search by last name of potential reviewers, or you can do an advanced search and search by name, first letter of last name, department or school/college. Previously established groups will also show up as Available Reviewers/Groups.

You may also assign reviewers from other units on campus besides your own.

Available Reviewers/Groups

Show 10 entries  
Search

MIV User/Group

No users or groups were found
0 to 0 of 0 entries

Assigned Dossier Reviewers/Groups

Show 10 entries  
Find in all :  

MIV User/Group

There are no users or groups assigned
Showing 0 to 0 of 0 entries

Save Reviewers  Save & Open Review Period  Cancel
Assigning Reviewers

Once you have one or more Available Reviewers/Groups on your list, you can add them to the Assigned Dossier Reviewers/Groups list by clicking on the "Add" button. The name of the available reviewer will move to the assigned reviewer column.

<table>
<thead>
<tr>
<th>MIV User/Group</th>
<th>IET - Application Development</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adler-Lund, Elisabeth</td>
<td></td>
</tr>
<tr>
<td>Barbulesco, Nicholas</td>
<td></td>
</tr>
<tr>
<td>Bernasconi, Patrick J</td>
<td></td>
</tr>
<tr>
<td>Blizard, David</td>
<td></td>
</tr>
<tr>
<td>Bray, Curtis</td>
<td></td>
</tr>
<tr>
<td>Cabral, Rose</td>
<td></td>
</tr>
<tr>
<td>Chapman, Todd</td>
<td></td>
</tr>
<tr>
<td>Chen, Johann</td>
<td></td>
</tr>
<tr>
<td>Clemente, Ramon</td>
<td></td>
</tr>
<tr>
<td>Fuller, Constance</td>
<td></td>
</tr>
</tbody>
</table>
Assigning Reviewers

When all reviewers (individual and groups) have been assigned, click “Save Reviewers.”

To remove a reviewer, click “Remove.”
Assigning Reviewers

Confirmation: Assigned Dossier Reviewers

Your dossier reviewer changes have been saved.

Name: Peter Siegel  
Appointment: Information and Educational Technology  
Location: Department  
Review Period: Open

<table>
<thead>
<tr>
<th>MIV User/Group</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abbott, Bruce T</td>
<td>General Library</td>
</tr>
<tr>
<td>Adler-Lund, Elisabeth</td>
<td>IET - Application Development</td>
</tr>
<tr>
<td>Bernasconi, Patrick J</td>
<td>IET - Application Development</td>
</tr>
<tr>
<td>Bray, Curtis</td>
<td>IET - Application Development</td>
</tr>
<tr>
<td>Chapman, Todd</td>
<td>IET - Application Development</td>
</tr>
<tr>
<td>Clemente, Ramon</td>
<td>IET - Application Development</td>
</tr>
</tbody>
</table>

Click “Done” if you are satisfied with your list of reviewers.
Assigning Reviewers

• When the review has been completed, you do not need to remove the assigned reviewers, you only need to close the review period

• If your assigned reviewers are unable to view the dossier, make sure that the review period has been opened

• You do NOT need to remove the name of the candidate from your list of reviewers if they are in an assigned group. MIV will not allow a candidate to see their own dossier as an assigned reviewer

• You WILL need to manually remove reviewers if they have a conflict of interest or will vote at another level (i.e., a spouse, or a member of the FPC, CAP or a Dean)
Candidate’s Disclosure Certificate

• The candidate’s dossier must be finalized before having them sign their disclosure certificate as they are approving that version of their dossier.
• From the open action page for your candidate, click Add/Edit on the Candidate’s Disclosure Certificate (CDC).

Open Action

Crystal Y Barber
Offices of the Chancellor and Provost
Non-Redelegated Merit 2014 Submitted on 10/07/2013, 1:19 PM
Department Location Last Routed on 10/07/2013, 1:19 PM

Primary Appointment: Offices of the Chancellor and Provost

Primary Appointment processing: In Progress

<table>
<thead>
<tr>
<th>Recommended Action Form</th>
<th>Add/Edit</th>
<th>View: Recommended Action Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department Letter/Division Chief Letter</td>
<td>Add/Delete</td>
<td>View: Department Letter/Division Chief Letter</td>
</tr>
<tr>
<td>Department Letter Federation Vote</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Department Peer Group Letter for Federation</td>
<td>Add/Delete</td>
<td>Optional - Not Added</td>
</tr>
<tr>
<td>Candidate’s Disclosure Certificate</td>
<td>Add/Edit</td>
<td>Required – Not Added</td>
</tr>
</tbody>
</table>
Candidate’s Disclosure Certificate

MIV pre-populates the disclosure certificate based on the information entered on the RAF.

The Additional Information box is not required for the initial CDC, but is required for subsequent versions (if the dossier is edited in any way) – list what was added or edited in the dossier here.

Click here to set up e-mail.

NOTE: Saved data for the Candidate’s Disclosure Certificate will not appear in the dossier single file PDF until it has been Emailed to the candidate for signature.
Candidate’s Disclosure Certificate

Send Candidate's Disclosure Certificate Email Notification

Send an email notification to the Candidate requesting a Disclosure Certificate signature. No documents will be sent to the Candidate via email attachment. The Candidate must log in to MIV to view his/her dossier, department’s recommendation, etc., and sign a Disclosure Certificate.

View Dossier as One PDF File: Merit 2014
Signature Requested for: Candidate’s Disclosure Certificate

From: Crystal Y Barber <cybarber@ucdavis.edu>
To: Crystal Y Barber <cybarber@ucdavis.edu>
Cc: 
Subject: MyInfoVault Candidate’s Disclosure Certificate requires signature

You are receiving this notification from the OFFICES OF THE CHANCELLOR AND PROVOST because the Disclosure Certificate for your Dossier is ready to be signed. Please follow these steps to sign your Disclosure Certificate:

* Log in to MyInfoVault to review your dossier as outlined in the Candidates Disclosure Certificate, the department’s recommendation (and redacted evaluations, if applicable) at http://mvdemo.ucdavis.edu/

* Select the “View My Complete Dossier/Sign My Disclosure Certificate”

Additional Information

It is a good practice to enter your e-mail address in the cc: line so that you receive the same notification message as the candidate.

You can add a personal note to the candidate in the “Additional Information” box.

Click here to send the e-mail
Candidate’s Disclosure Certificate

• You will get a confirming message once the CDC e-mail is sent to the candidate

  Send Candidate’s Disclosure Certificate Email Notification: Confirmation

  Candidate’s Disclosure Certificate signature request was sent on 10/07/13, 1:36 PM
  To: Crystal Y Barber

• You will not get an e-mail or any other notification that the CDC has been signed
• You will need to go back into the open action to check the status of the CDC
• As soon as the candidate signs the disclosure, the open action page will reflect that the CDC is now signed (you may have to refresh your screen)

• Signing the CDC should be the last step before the dossier is forwarded to the School/College, as it indicates the candidate has reviewed and approved the action in its current format
• Subsequent changes to the dossier will require a new CDC to be signed
Once the RAF is complete, all required documents are uploaded, the review period closed, and the disclosure is signed, the action is considered “completed” and the link to send the dossier to the school/college becomes active.
It’s done – time to celebrate!

- As soon as the dossier is completed and the link to forward it to the school/college becomes active, click on it, the dossier will magically disappear, and you will get the following confirming message:

Open Action

The following action has been sent to the School/College.

Pete Peterson
Information and Educational Technology - Application Development
Non-Delegated Merit 2013 Submitted on 12/28/2012, 8:53 AM
School/College Location Last Routed on 09/25/2013, 3:44 PM

View the Dossier as One PDF File
View the Signature Log
Additional Information

• MIV is a joint effort between Academic Affairs and Information and Educational Technology
• As a team, we work with the campus to identify possible enhancements and translate them into efficiently working technology
  • Two committees have input into enhancements:
    • The MIV User’s Group (meets every other month)
    • The MIV Campus Oversight Committee (meets twice a year)
• We also provide “help desk” service M-F, 8-5. To use that feature, click on “Contact Us” in the upper right hand corner of your screen.
Contact Us

• To report errors or request assistance, click on “Contact Us” in the upper right hand corner of your main page
• Send a detailed message to miv-help@ucdavis.edu
• Provide as many details as possible about the problem you are experiencing, as this will help us solve your problem that much sooner (i.e., whose account/dossier are you in, what were you trying to do, what error message did you receive, etc.)
• Sending us a screen shot of your error or problem is always appreciated
Other Resources

• “Help” or “How do I get started” on your MIV main page

• Academic Affairs MIV Webpage
  • This page has a variety of training resources for both academic users and admins at the department, school/college, and Academic Senate level
  • https://academicaffairs.ucdavis.edu/tools/miv-information/training-resources.html